TD-9441E3B-A - Cerna - 2.8 mm
4AMP venkovni IP kamera s IR

verze FW 5.2.0

Uzivatelsky manual

Bezpecnostni instrukce

Varovani: Upozoriiuje na nizké az stfedni riziko, které miiZe zpisobit lehké zranéni.

Upozornéni: Upozoriiuje na riziko, které mtize zpisobit ztratu dat, poSkozeni zafizeni nebo snizeni
jeho vykonu.

Poznamka: Poskytuje dodatecné informace nebo dopliiuje ¢ast predchoziho textu.

O tomto manualu

Tento manual je pouZit pro vice modeld. Veskeré obrazky, tabulky a pfiklady jsou pouze
orientaCni. MitiZe tak dojit k rozporu mezi manuéalem a produktem.

Prostudujte si tento manual pro zajiSténi spravného a bezpecného pouZivani zatizeni.

V tomto manudlu se mohou vyskytnout typografické chyby a technické nepresnosti. Opravy
budou soucasti nové verze manualu. Obsah manuédlu se miZe zménit bez predchoziho
upozornéni.

Pouziti produktu

Je zakazano pouZzivat produkt k nelegalnim uceltim.

Spolecnost ELNIKA plus s.r.0. nepovoluje a neschvaluje pouziti svych produkti k naruseni
soukromi, prdva na ochranu osobnich udajt, atd. Pouziti produktu k témto ucelim je
zakazano.

PFi pouZivani by uZivatel nemél produkt poskodit, vyradit, pretiZit nebo jakymkoliv jinym
zpusobem ovlivnit jeho funkci.

Je zakéazano ziskat pristup k produktu nebo softwaru pomoci hackovani, kradeze hesla, atd.

Elektricka bezpeénost

PouZivejte pouze napajeci zdroj urCeny k tomuto zafizeni. NepouZivejte zafizeni v
nadmoftskych vyskach nad 2000 m nebo teplotach nad 60°C.

Varovani: Nespravna instalace a/nebo manipulace miiZe zptisobit poZar nebo elektricky Sok.
Produkt musi byt uzemnén za icelem minimalizace rizika elektrického Soku.
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Varovani: Pred rozebranim zatizeni si nasad’te antistatické rukavice nebo vybijte statickou
elektfinu, ktera se nahromadila ve VaSem téle.

Upozornéni: Nenapdjejte zatfizeni dvéma zdroji soucasné, pokud neni uvedeno jinak. Mohlo
by dojit k poSkozeni zafizeni.

Pracovni prostredi

Béhem transportu, skladovani a instalace chrariite zafizeni pred narazy, silnymi vibracemi,
silnym tlakem a vodou. Jejich vlivem by mohlo dojit k poSkozeni citlivych ¢asti.

Objektiv kamery by nemél miFit na extrémné jasny objekt (naptiklad slunce). Mohlo by dojit
k poSkozeni snimaciho ¢ipu kamery.

Neinstalujte zafizeni pobliz zdroji tepla (radiatori, sporakd, atd). Mohlo by dojit k jeho
prehrati.

Neinstalujte kameru pobliz vydechu klimatizace. Kondenzujici voda by mohla zptsobit
zhorsSeni kvality obrazu nebo poSkozeni kamery.

Neinstalujte zafizeni do prasného, vlhkého, extrémné chladného/horkého prostredi, prostredi
se silnou elektromagnetickou radiaci nebo prostiedi s nestalym osvétlenim.

Ujistéte se, Ze se pobliZz kamery nenachazi reflexni povrch (zrcadlo, sklo, atd). OdraZené
svétlo IR prisvitu miiZe zptisobit rozmazani obrazu.

Operace a denni udrzba

Zatizeni neobsahuje Zadné komponenty, které by mohly byt opraveny uZivatelem. V ptipadé
poruchy kontaktujte servisni oddéleni.

Pred zah4ajenim udrZzby odpojte zafizeni od napajeni.

Varovani: VeSkeré prohlidky a idrzbu by mél provadét pouze kvalifikovany personal.
Nedotykejte se snimaciho Cipu ani krytu objektivu. K odstranéni nahromadéného prachu
pouZijte fén.

K ciSténi kamery pouZivejte pouze suchy, mékky hadfik. Pokud se vSak na kamere
nahromadilo priliS mnoho prachu, pouZziti hadfiku miiZe zpisobit zhorSeni funkcnosti IR
prisvitu nebo odrazy IR svétla. V takovém pripadé pouZijte fén.

Kryt objektivu je optické zatizeni, proto se ho nedotykejte a neutirejte ho. K odstranéni
prachu pouZijte fén nebo mékky kartacek, jehoZ Stétiny neobsahuji Zadné komponenty
vyrobené z ropy. K odstranéni mastnoty nebo otiski prstii pouZijte bavinény hadfik, ktery
neobsahuje Zadné komponenty vyrobené z ropy, nebo papir namoceny do neutralniho
Cisticiho prostredku. Pri CiSténi postupujte od stfedu ven. Méiite papir/hadrik podle potteby.

Ochrana soukromi

® Pri instalaci kamery do vefejného prostoru je nutné pobliZz umistit vyrazné a jasné

upozornéni na monitorovani a oznacit monitorovany prostor.

® Osobni udaje budou zpracovavany uzZivatelem produktu.
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Odpovédnost

Z hlediska internetové bezpecCnosti kupujici pouZiva produkt na své vlastni riziko.
Spolecnost ELNIKA plus s.r.o. nenese odpovédnost za Skody zplisobené nespravnym
pouzitim, unikem citlivych dat nebo jinym poSkozenim zplisobenym kybernetickym
utokem, hackerskym utokem, virem nebo jinym internetovym nebezpeCim. SpoleCnost
ELNIKA plus s.r.o. ovSem poskytne technickou podporu v pripadé nutnosti.

Zakony tykajici se monitorovani se lisi stat od statu. Spolecnost ELNIKA plus s.r.o0. nenese
odpovédnost za Skody zptisobené nezdkonnym pouZzitim produktu.

Kyberneticka bezpecénost

Pouzivejte silné heslo. Za silné se povazuje heslo skladajici se minimalné z 8 znakd, které
obsahuje malé a velké pismeno, Cislici a specialni znak.

Pravidelné mérite heslo. Doporucena maximalni doba platnosti hesla je 90 dni.

Je doporuceno zmeénit vychozi porty (HTTP/HTTPS port, datovy port, atd) za dcelem
minimalizace rizika neopravnéného pristupu.

V routeru zapnéte firewall. Dtlezité porty (HTTP/HTTPS port, datovy port, atd) by vSak
nemély byt blokovany.

Neni doporuceno pripojovat zarfizeni k verejné siti. Pokud se tomu nelze vyhnout, pouZijte
externi hardwarovy firewall.

Neni doporuceno pouZivat SNMP verze 1 a 2.

Pro zlepSeni zabezpeceni webového klienta nainstalujte TLS certifikat a zapnéte HTTPS.
Zapnéte filtrovani IP adres. Tim zabranite v pristupu kazdému, kdo neni na seznamu.
Omezte opravnéni docasnych Gctl. Prifazujte uzivatelim pouze ta opravnéni, ktera nezbytné
pottebuji pro svou praci.

Funkce UPnP automaticky provede presmérovani porti. To je sice pro uZivatele pohodlné,
zvySuje ovSem riziko uniku citlivych dat. Pokud tato funkce neni pouzivana, méla by byt
vypnuta.

Pravidelné kontrolujte logy. V nich najdete IP adresy a provadéné operace.

Standardy

G

Tento vyrobek odpovid4 zakladnim poZadavkiéim nafizeni vlady CR a odpovidajicim evropskym
predpisim pro posuzovani shody elektrotechnickych zafizeni: smérnice pro elektromagnetickou
kompatibilitu (EMC) - nafizeni vlady NV ¢. 117/2016 Sb. (evropska smérnice 2014/30/EU ) a
smérnici o omezeni pouZivani nékterych nebezpecnych latek v elektrickych a elektronickych
zatizenich (RoHS) - nafizeni vlady NV ¢. 481/2012 Sb. (evropska smérnice 2011/65/EU a jeji
novela 2015/863) - v platném znéni. Vyrobek je oznacen znackou shody s evropskymi predpisy
CE. Je na néj vystaveno EU prohlaseni o shodé.
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RoHS - (Restriction of use of Hazardous Substances)

Produkt byl navrZen a vyroben v souladu s direktivou RoHS 2011/65/EU a jeji novelou 2015/863
tykajici se omezeni pouZiti nékterych nebezpeCnych latek v elektrickych a elektronickych
zatizenich. Cilem direktivy RoHS je zakazat pouZivani nebezpecnych latek pri vyrobé elektrického
a elektronického zarizeni a tim prispét k ochrané lidského zdravi a Zivotniho prostfedi. Direktiva
RoHS zakazuje pouZiti téchto latek: kadmium a jeho slouceniny, rtut” a jeji slouceniny, olovo a jeho
slouCeniny, Sestimocny chréom a jeho slouceniny, polybromované bifenyly (PBB), polybromované
difenylethery (PBDE), benzylbutyl ftalat (BBP), Dibutyl ftalat (DBP), bis(2-ethylhexyl) ftalat
(DEHP), diisobutyl ftalat (DIBP).

Z!l Vykfricnik v trojuhelniku upozoriiuje uZivatele na operace vyZadujici zvySenou opatrnost a
dodrzovani pokynti uvedenych v navodu.

A Symbol blesku v trojuhelniku oznacuje soucasti, zakryvajici neizolované casti pod napétim,
jejichZ odstranéni muize vést k trazu elektrickym proudem.

Direktiva 2012/19/EU (WEEE)

— Tento symbol na vyrobku nebo na jeho baleni oznacuje, Ze je zakazano vyrobek likvidovat
spolecné s komunalnim odpadem. PouZity elektricky nebo elektronicky vyrobek jste povinni
odevzdat na vyhrazeném sbérném misté k dalSi recyklaci. Oddéleny sbér a recyklace pouZitych
elektrickych a elektronickych vyrobk poméaha zachovéavat prirodni zdroje a zajiStuje, Ze bude
recyklace provedena takovym zptisobem, ktery neposkozuje lidské zdravi a Zivotni prostiedi. Dalsi
informace o nejbliz§im sbérném misté, na kterém miZete odevzdat pouZity elektricky nebo
elektronicky vyrobek, vam poskytne organ mistni samospravy, nejbliZsi sbérna sluzba nebo
prodejce, u kterého jste vyrobek zakoupili.

Direktiva 94/62/EC

@A

Tato direktiva se zabyva obaly a obalovymi materialy. VeSkeré obaly produktu je nutné umistit do
prislusnych nadob na tfidény odpad, nemély by byt likvidovany spolecné s komunalnim odpadem.

Direktiva EC1907/2006 (REACH)

Direktiva REACH se zabyva registraci, posuzovanim, autorizaci a omezenim pouZiti chemickych
latek za tCelem ochrany lidského zdravi a Zivotniho prostiedi. Produkt spliiuje poZadavky kladené
direktivou REACH.
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1 Uvod

Vlastnosti
® Automatické prepinani ICR, funkce True Day/Night
3D DNR, WDR
BLC, OdmlzZeni, Anti-flicker, chytré IR, vzor Chodba
ROI kdodovani
P2P
Detekce tvare, PrekroCeni linie/NaruSeni oblasti/Vstup do oblasti/OpusSténi oblasti
(Clovékem/vozidlem), Detekce vyjimky videa, Tepelna mapa, Pocitani cild, atd.
® Vzdaleny dohled pres chytry telefon s opera¢nim systémem iOS nebo Android.

2 Sit'ové pripojeni

Systémové pozadavky

Operacni systém: Windows 7 Home Basic nebo lepsi

CPU: 2.0 GHz nebo lepsi

RAM: 1 GB nebo lepsi

Monitor: rozliSeni minimalné 1920x1080 (je doporuceno vyssi)

Webovy prohlizec: Internet Explorer (je vyZadovan ovladaci prvek ActiveX), Firefox, Edge,
Google Chrome, Safari

UZivatelské rozhrani se mtize liSit podle toho, jestli je ve webovém prohliZeci nainstalovan ovladaci
prvek Free Live View. ProhliZec s ovladacim prvkem podporuje vice funkci. NiZe uvadime webovy
prohliZe¢ Internet Explorer jako priklad.

2.1 LAN

2.1.1 Pristup pres IP-Tool

1) Ujistéte se, Ze kamera i PC jsou pripojené k lokalni siti a v PC je nainstalovan program IP-
Tool.

2) Spustte IP-Tool.

3) Vychozi IP adresa kamery je 192.168.226.201. Dvojklikem na tuto adresu se ke kamere
pripojite pres vychozi webovy prohliZzec¢. Po precteni prohlaSeni o ochrané soukromi
kliknéte na Already Read. Zvolte lokaci a kliknéte na DalSi (Next). Zvolte oblast (Zone),
format videa (PAL, NTSC), format data a Casu, pak kliknéte na DalSi (Next). Zadejte heslo
k aktivaci kamery. Pokud zaskrtnete Shoda s Onvif heslem (Match Onvif Password), s
timto tc¢tem se bude moZné pripojit ke kamefe pres platformu tfeti strany pomoci protokolu
ONVIF. Potom kliknéte na DalSi (Next).

4) Zvolte bezpecnostni otazky pro resetovani hesla uZivatele admin a zadejte odpovédi. Poté
kliknéte na Ulozit (Save). Systém se poté restartuje. Po precteni prohlaSeni o ochrané
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soukromi kliknéte na Already Read. Pfi prvnim prihlaSeni je nutné nainstalovat ovladaci
prvek ActiveX. Aktualizujte stranku, objevi se prihlaSovaci okno. Zadejte heslo, zvolte
stream a systémovy jazyk, pak kliknéte na Prihlasit (Login).

TD-9441E3B-A - Cerna (2.8 mm) - 4MP venkovni IP kamera s IR

Pokud zapomenete heslo, kliknéte na Zapomenuté heslo (Forgot Password) a zadejte odpovédi na
zobrazené bezpecnostni otazky. Tim dojde k resetovani hesla.

2.1.2 Pfimy pfistup pfes webovy prohlize¢
Vychozi sitové parametry kamery jsou nasledujici:

IP adresa (IP Address): 192.168.226.201

Maska podsité (Subnet Mask): 255.255.255.0

Brana (Gateway): 192.168.226.1

HTTP port: 80

Datovy port: 9008

PTi prvnim prihlaseni pouZijte tyto tidaje. Pfipojte kameru pfimo k PC sitovym kabelem.
1) Oteviete Centrum siti a sdileni a zvolte Lokalni sit’. Zde kliknéte na Vlastnosti > IPv4 >
Vlastnosti a zméiite IP adresu PC.
2) Spustte webovy prohliZe¢ a zadejte do néj vychozi IP adresu kamery. P¥i prvnim pfihlaseni
je nutné nainstalovat ovladaci prvek ActiveX.
3) Zadejte uZivatelské jméno, heslo, zvolte stream a systémovy jazyk, pak kliknéte na Prihlasit
(Login).

2.2 WAN

2.2.1 Pristup pfes P2P

Nejprve je nutné zapnout funkci P2P. Kliknéte na Nastaveni (Config) > Sit’ (Network) > P2P. Pak
zadejte do webového prohliZzeCe adresu www.autonat.com pro vzdalené pripojeni k webovému
klientovi.

2.2.2 Pristup pres routerlvirtualni server

1) Ujistéte se, Ze kamera je pripojena k lokalni siti. V menu pak kliknéte na Nastaveni
(Config) > Sit’ (Network) > Port a nastavte adresy portu.

2) Kliknéte na Nastaveni (Config) > Sit’ (Network) > TCP/IP a nastavte IP adresu a dalsi
sitové parametry.

3) V routeru nastavte presmérovani HTTP/HTTPS portu a datového portu na lokalni IP adresu
kamery.

4) Do webového prohliZeCe zadejte WAN IP adresu kamery (IP adresu routeru) a HTTP port,
napriklad 192.168.1.201:81.
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2.2.3 Pristup pres PPPoE

1) Ujistéte se, Ze kamera je pripojena k lokalni siti. V menu pak kliknéte na Nastaveni
(Config) > Sit’ (Network) > Port a nastavte adresy portd.

2) Kliknéte na Nastaveni (Config) > Sit’ (Network) > TCP/IP > PPPoE. Zde zapnéte PPPoE
a zadejte uZivatelské jméno a heslo od poskytovatele.

3) Kliknéte na Nastaveni (Config) > Sit’ (Network) > DDNS. Pred provedenim tohoto kroku
je nutné si zaregistrovat doménu.

4) Do webového prohliZeCe zadejte doménu a HTTP port.

2.2.4 Pristup pres statickou IP adresu

1) Ujistéte se, Ze kamera je pripojena k lokalni siti. V menu pak kliknéte na Nastaveni
(Config) > Sit’ (Network) > Port a nastavte adresy portu.

2) Kliknéte na Nastaveni (Config) > Sit’ (Network) > TCP/IP a nastavte IP adresu a dalsi
sitové parametry.

3) Do webového prohliZece zadejte WAN IP adresu kamery a HTTP port.

3 Zivé video

Po prihlaseni se zobrazi Zivy obraz kamery.

w&bstmmhﬁm,m 'a =

BEED B (¢ @ & Q)@ [5) 2 O
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Indikator zdznamu na SD kartu

Popis ikon
Ikona Popis Ikona Popis
Ptivodni velikost obrazu @) |Indikator senzorového alarmu
) Uprava méfitka obrazu % |Indikator detekce pohybu
Obraz vyplni okno & Indikator abnormalnich barev
Na celou obrazovku a Indikator rozmazani obrazu
m Zapnuti/vypnuti Zivého videa o Indikator zmeény scény
Obousmérné audio (podle modelu) (=, |Indikator pfekroceni linie
Zapnuti/vypnuti zvuku £ |Indikétor naruseni oblasti
@ Momentka -] Indikator vstupu do oblasti
_[ﬁ Lokalni zdznam «] |Indikator opusténi oblasti
_ PribliZeni obrazu ,[ Indikator detekce tvare
@ Oddaleni obrazu |~ |Indikator pocitani prekroceni linie
_[E] Ovladani objektivu (podle modelu) Indikator pocitani naruSeni oblasti
@ Zachycené tvare @ |Indikator opusténého/chybéjiciho
objektu
©| |Zobrazeni pravidel ® |Indikétor tepelné mapy
B - PTZ ovladani (podle modelu) 4% |Indikator hustoty davu
O
o

tato funkce je zapnuta.
® ReZim Na celou obrazovku zrusite dvojklikem nebo klavesou Esc.
® Webovy prohliZec bez ovladaciho prvku Free Live View:

=» PTZ ovladani neni podporovéano

=» Obousmérné audio neni podporovéano

Indikator chytrého alarmu bude blikat pouze v pripad€, Ze kamera danou funkci podporuje a

=» Piepinani rezimu néahledu (Realny cCas/Real-time, Vyvazeny/Balanced, Plynuly/Fluent)

Ovladani objektivu (pouze u néktervch modehi)

neni podporovano

Ikona Popis Ikona Popis
#8% | Oddaleni obrazu ¥ 1 PribliZeni obrazu
& | Zmen3eni ohniskové vzdalenosti M\ |ZvétSeni ohniskové vzdalenosti
o Zaostreni jednim tlacitkem
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PTZ ovladani (pouze u nékterych modeli)

Ikona Popis Ikona Popis
Smérové Nataceni PTZ kamery; stfedové = ==®* | Rychlost nataceni kamery
Sipky tlacitko zastavi pohyb kamery

- 3 Oddaleni obrazu ¥ 1 PribliZeni obrazu

L ZmenSeni ohniskové vzdalenosti A ZvétSeni ohniskové vzdalenosti
[N Pfivieni clony W) Pootevieni clony

O Automaticky sken AW Stérac

@ Svétlo X3 Nahodny sken

& Skupinovy sken Fr Prepozice

Prepozice
Ikona Popis Ikona Popis
Vyvolani prepozice = UloZeni prepozice

[} Smazani prepozice

Zachycené tvare

1) Kliknéte na Nastaveni (Config) > Udalost (Event) > Detekce tvare (Face Detection). Zde
zaSkrtnéte Povolit (Enable).
2) V Zivém videu kliknéte na (2|
Sub stream| Third stream

@ 2

Balanced ~

/21 1T 60z 16

) o

Zachycené tvare se zobrazuji na pravém panelu.
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4 Nastaveni

Kliknéte na Nastaveni (Config).

Poznamka: Po kazdé zméné parametru kliknéte na Ulozit (Save) pro uloZeni nového nastaveni.
4.1 Systémové nastaveni

4.1.1 Zakladni informace

Kliknéte na Nastaveni (Config) > Systém > Zakladni informace (System Information). Zde si
miiZete ovérit Jméno zarfizeni (Device Name), Model produktu (Product Model), Znacku (Brand),
Verzi softwaru (Software Version), datum vydani soucasné verze softwaru (Softgware Build Date),
Verzi onvif (Onvif Version), MAC adresu nebo ID zafizeni (Device ID). Kliknutim na Prohlizet
(View) mtzZete zobrazit Informace o zafizeni (About this machine) nebo ProhlaSeni o ochrané
soukromi (Privacy Statement).

Zde také najdete QR kéd pro rychlé pridani kamery do mobilni aplikace, pokud je zapnuta funkce
P2P.

4.1.2 Datum a ¢as

Kliknéte na Nastaveni (Config) > Systém > Datum a ¢as (Date and Time). Zde nastavte Casové
pasmo (Time Zone).

Poznamka: Kamera a PC musi mit stejné casové pasmo. Je doporuCeno nastavit ¢asové pasmo
kamery podle PC. Pokud je casové pasmo PC zménéno, je nutné restartovat webového klienta.

Poté nastavte reZim synchronizace ¢asu. Mate na vybér nékolik moZnosti.
» Synchronizovat s NTP serverem (Synchronize with NTP server): zadejte adresu NTP
serveru a periodu aktualizace ¢asu (v minutach)
» Nastavit rucné (Set Manually): rucné zadejte cas
» Pro synchronizaci casu s PC zvolte Nastavit rucné (Set Manually) a zaskrtnéte
Synchronizovat s lokalnim ¢asem pocitace (Sync with computer local time).

Pro nastaveni letniho ¢asu kliknéte na zalozku Letni ¢as (Summer Time). Zde zaSkrtnéte DST a
zvolte bud’ automaticky letni ¢as (Auto DST), nebo rucni letni ¢as (Manual DST).

4.1.3 Lokalni nastaveni

Kliknéte na Nastaveni (Config) > Systém > Lokalni nastaveni (Local Config). Kliknéte na
Prochazet (Browse) pro nastaveni Cesty k momentkdm (Picture Path) a Cesty k zaznamtim
(Record Path). Pro zapnuti zaznamu zvuku nastavte poloZku Nastaveni audia videa (Video Audio
Settings) na Otevieno (Open). Pro zobrazeni datového toku pfi prehravani zaznamu nastavte
polozku Ukazat datovy tok (Show Bitrate) na Otevieno (Open). Pro ukladani alarmovych
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momentek do PC nastavte poloZku Lokalni chytré tilozisté momentek (Local Smart Snapshot
Storage) na Otevieno (Open).

TD-9441E3B-A - Cerna (2.8 mm) - 4MP venkovni IP kamera s IR

Poznamka: Pokud ve webovém prohliZeci neni nainstalovan ovladaci prvek Free Live View, lze
zapnout pouze zobrazeni datového toku.

4.1.4 Ulozisté

Kliknéte na Nastaveni (Config) > Systém > UloZisté (Storage). Zde si miiZete ovéfit celkové
misto vyhrazené pro momentky (Total picture capacity), zbyvajici misto pro momentky (Picture
remaining space), celkové misto vyhrazené pro zaznamy (Total recording capacity), zbyvajici misto
pro zaznamy (Record remaining space) a stav SD karty (State).

Sprava SD karty

Kliknéte na Fomatovat (Format) pro zformatovani SD karty. Pfi formatovani budou smazana
veSkera data na karté.

Kliknéte na Vysunout (Eject) pro ukonceni zapisu na SD kartu, aby ji bylo moZné bezpecné
vyjmout.

Kvota momentek (Snapshot Quota): misto na SD karté vyhrazené pro momentky

Kvota videa (Video Quota): misto na SD karté vyhrazené pro zaznamy

Nastaveni zaznamu

Kliknéte na zalozku Zaznam (Record). Zde miZete zvolit zdznamovy stream (Hlavni stream/Main
Stream, Vedlejsi stream/Sub Stream, Tteti stream/Third Stream), dobu zaznamu pred alarmovou
udalosti (Pre Record Time) a podle potieby zapnéte recyklaci zaznami pfi zaplnéni SD karty (Cycle
Write). Pro nastaveni Casového planu zaSkrtnéte Povolit planovany zaznam (Enable Schedule
Record).

Tydenni plan (Week Schedule)

Planovac je rozdélen na 7 fadkd (dnd v tydnu; prvni je nedéle), kazdy fadek je dale rozdélen na 24
dilkt (hodin). Zelené zvyraznéna cast indikuje zaznam. Zvolte PFridat (Add) a taZzenim mySi po
radku oznacte Casovy usek podle potfeby. Pro smazani zvolte Smazat (Erase) a taZenim mysi po
radku zvolte casovy tsek podle potfeby. Pokud kliknete na Rucni vstup (Manual Input), miZete
zadat Casovy usek rucné, s presnosti na minuty. Pro zkopirovani nastaveni kliknéte na Pouzit
nastaveni na (Apply settings to), zaskrtnéte dny v tydnu a kliknéte na OK. Pro oznaceni celého
radku kliknéte na Zvolit vSe (Select All). Pro uplného oznaceni vSech fadku kliknéte na Zvolit vSe
(Select All) na horni listé. Pro smazani vSech tseki na fadku kliknéte na Smazat vse (Clear All).
Pro uplného smazani vSech tsekd na vSech fadcich kliknéte na Smazat vSe (Clear All) na horni
listé. Pokud kliknete na Obratit (Invert), zaznam bude probihat mimo oznacené oblasti.

Svatecni plan (Holiday Schedule)
Zadejte datum, taZzenim mySi po fadku oznacte casovy usek podle potfeby a kliknéte na + pro
pridani planu. Pro smazani planu ho oznacte a kliknéte na -.
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Poznamka: SvateCni plan ma prednost pred tydennim planem. Pokud tedy pro urcity den existuje
zaroven tydenni i svate¢ni plan, tydenni plan bude ignorovan.

TD-9441E3B-A - Cerna (2.8 mm) - 4MP venkovni IP kamera s IR

Nastaveni momentek
Kliknéte na zalozku Momentka (Snapshot). Zde muzZete nastavit Format obrazu (Image Format),
RozliSeni (Resolution) a Kvalitu obrazu (Image Quality).

Pak nastavte interval mezi momentkami (Snapshot Interval) a maximalni poCet momentek v sérii
(Snapshot quantity).

Poznamka: Pokud je doba trvani alarmu kratSi neZ doba potiebna pro porizeni celé série, vysledny
pocet momentek bude mensi neZ zadana hodnota.

Pro zapnuti automatického pofizovani momentek zaskrtnéte Povolit ¢asovani momentek (Enable
Timing Snapshot) a nastavte Casovy plan (viz vysSe).

FTP momentka
Kliknéte na zadloZku FTP momentka (FTP Snapshot). Zde zaskrtnéte Povolit casovani momentek
(Enable Timing Snapshot), zadejte adresu FTP serveru a nastavte ¢asovy interval (v sekundach).

4.2 Nastaveni obrazu

4.2.1 Nastaveni zobrazeni

Kliknéte na Nastaveni (Config) > Obraz (Image) > Zobrazeni (Display). Zde mtzZete nastavit
parametry BéZného rezimu (Common), Denniho rezZimu (Day) a Noc¢niho reZimu (Night).
Jas (Brightness): troven jasu obrazu
Kontrast (Contrast): barevny rozdil mezi nejtmavsim a nejsvétlejSim mistem obrazu
Odstin (Hue): podil barevnych sloZek v obraze
Sytost (Saturation): mira Cistoty barev; ¢im je tento parametr vyssi, tim je obraz jasnéjsi
Ostrost (Sharpness): rozliSeni plochy obrazu a mira ostrosti kraji obrazu
Redukce Sumu (Noise Reduction): redukce Sumu (zrnéni) v obraze; zvySeni této hodnoty
posili funkci, ale také sniZi celkové rozliSeni obrazu
Odmlzeni (Defog): zapnuti této funkce a nastaveni adekvatni hodnoty je dtilezité za koure,
mlhy, smogu, hustého dest€, atd
» Automaticka clona (Auto Iris): tuto funkci zapnéte, pokud kamera ma automatickou
clonu. V opac¢ném pripadé ji nechte vypnutou.
» Kompenzace protisvétla (BLC):
=> Vypnuto (Off): funkce je vypnuta (vychozi nastaveni)
= HWDR: tato funkce zlepSuje kvalitu obrazu, pokud se v ném vyskytuji velmi svétla i
velmi tmava mista; pri zapnuti WDR se prerusi zaznam na nékolik sekund
= HLC: tato funkce sniZi celkovy jas obrazu zamaskovanim presvétleného mista a
redukci korony

YV V VYVYY

Y
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=» BLC: tato funkce upravi expozici scény tak, aby objekty v nejtmavsi Casti obrazu byly
jasné viditelné

» Antiflicker: nestalé svételné podminky (napriklad osvétleni vybojkou)
=> Vypnuto (Off): funkce je vypnuta
=» 50Hz: omezuje blikani pfi frekvenci 50 Hz
=» 60Hz: omezuje blikani pfi frekvenci 60 Hz

» Chytré IR (Smart IR): tato funkce kompenzuje preexponovani scény

» Vyvazieni bilé (White Balance): tato funkce automaticky upravi teplotu barev podle
prostredi

» Rezim den/nmoc (Day/Night Mode): Ize zvolit Auto, Den (Day), Noc (Night), nebo
Casovani (Timing)

» Zavérka (Shutter): tato funkce umoziiuje nastavit horni limit expozicni doby; expozi¢ni
doba bude automaticky upravena podle okolnosti

» Zisk (Gain): tato funkce umoziiuje nastavit horni limit zesileni signalu; zisk bude nastaven
automaticky podle okolnosti

» Korekce zakriveni objektivu (Lens Distortion Correction): zapnéte tuto funkci, pokud je
obraz zakfiven; hodnotu nastavte podle potieby

» Frekvence (Frequency): lze nastavit 50Hz, nebo 60Hz

» InfraCerveny rezim (Infra-red Mode): lze zvolit Auto, Zapnuto (On), nebo Vypnuto
(Off)

» Vzor Chodba (Corridor Pattern): rezZim pro dlouhé chodby; lze nastavit 0° (vychozi
nastaveni), 90°, 180°, nebo 270°

» Zrcadleni obrazu (Image Mirror): tato funkce prevrati obraz horizontalné

» Prevraceni obrazu (Image Flip): tato funkce prevrati obraz vertikalné

Planovac

Kliknéte na zaloZku Sprava profili (Profile Management). Zde miiZete nastavit asovy plan pro
Obecny rezim (Common), Denni reZim (Day), Noc¢ni reZim (Night) a automatické prepinani mezi
dennim a no¢nim reZimem (Timing). Zvolte Casovani (Timing) a pomoci posuvnikii nastavte
hranice mezi dennim a no¢nim reZimem. Modra indikuje denni reZim, Seda indikuje nocni reZim.

4.2.2 Nastaveni video/audio streamu

Kliknéte na Nastaveni (Config) > Obraz (Image) > Video/Audio.
Poznamka: Nastaveni se u riiznych kamer miiZe liSit. NiZe popsané nastaveni je pouze orientacni.

Obraz

Kliknéte na zalozku Video.

>
>

>

Rozliseni (RozliSeni): velikost obrazu

Snimkovani (Frame Rate): pocet snimkii za sekundu; ¢im je tento parametr vyssi, tim je
video plynulejsi

Typ datového toku (Bitrate Type): I1ze zvolit CBR (konstantni datovy tok), nebo VBR
(proménny datovy tok)
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> Datovy tok (Bitrate): tento parametr lze nastavit v pripadé, Ze typ datového toku je
nastaven na CBR
» Kvalita videa (Video Quality): tento parametr lze nastavit, pokud je typ datového toku
nastaven na VBR; ¢im vyssi je kvalita obrazu, tim vy3si bude datovy tok
> Interval mezi snimky (I Frame Interval): interval mezi skupinou snimki; pokud pred
kamerou neni pfiliS mnoho pohybu nastaveni této hodnoty nad snimkovani sniZi datovy tok;
pokud je vSak pfed kamerou hodné pohybu, nastaveni prilis vysoké hodnoty miZe zpiisobit
preskakovani snimk
» Komprese videa (Video Compression): 1ze zvolit MJPEG, H.264+, H.264, H.265+, nebo
H.265. MJPEG nelze zvolit u Hlavniho streamu. Pokud zvolite H.265, ujistéte se, Ze
klientsky systém dokaZe signal dekddovat. V porovnani s H.265 komprese H.265+ zabira
méné mista na disku pri stejném datovém toku. V porovnani s H.264 komprese H.265 ma
nizsi datovy tok za stejnych podminek.
» Profil (Profile): profil H.264; 1ze zvolit Zakladni (Baseline), Hlavni (Main), nebo Vysoky
(High)
» Zaslat momentku (Send Snapshot): stream pro zasilani momentek
» Rozdéleni casti kédovani videa (Video encode slice split): tato funkce zajisti plynulé
video i na méné vykonném PC
» Vodoznak (Watermark): zaskrtnéte Vodoznak (Watermark) a vypliite Obsah vodoznaku
(Watermark Content)
Zvuk
Kliknéte na zaloZku Audio.
» Povolit (Enable): zapnuti zvuku
» Kodovani audia (Audio Encoding): 1ze zvolit G711A, nebo G711U
» Typ audia (Audio Type): lze zvolit MIC (vestavény mikrofon), nebo LIN (audio vstup)
» Hlasitost MIC In/LIN In (MIC In/LIN In Volume): hlasitost zvoleného vstupu
» Hlasitost audio vystupu (Audio out Volume): hlasitost audio vystupu
4.2.3 OSD
Kliknéte na Nastaveni (Config) > Obraz (Image) > OSD.
» Ukazat casové razitko (Show Timestamp): zobrazeni data a ¢asu
=» Format casu (OSD Time Format)
=» Format data (OSD Date Format)
» Ukazat jméno zarizeni (Show Device Name)
=>» Jméno zarizeni (Device Name)
» OSD obsah (OSD Content): uZivatelem definovany text

=>» Pridat radek (Add One Line)
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Prekryti obrazkem

Zaskrtnéte OSD obsah1 (OSD Contentl), pomoci rozbalovaciho menu zvolte Prekryti obrazkem
(Picture Overlay) a kliknéte na~< pro vybér obrazku. Kliknéte na Otevrit (Open) pro nahrani
obrazku. Velikost obrazku nesmi byt vétsi nez 200x200 pixeld, jinak ho nebude mozné nahrat.

4.2.4 Video maska

Tato funkce umoziuje zakryt ¢ast obrazu za uicelem ochrany soukromi. Lze vytvorit aZ 4 masky.
Kliknéte na Nastaveni (Config) > Obraz (Image) > Video maska (Video Mask).

Vytvoreni masky
1. Zaskrtnéte Povolit (Enable).
2. Kliknéte na Nakreslit oblast (Draw Area) a taZzenim mySi oznacte oblast, kterou chcete
zamaskovat.
3. Kliknéte na Ulozit (Save).
4. Vratte se do Zivého videa pro ovéfeni funkcnosti masky.

Smazani masky
Kliknéte na Smazat (Clear).

4.2.5 ROI

Tato funkce umozZiiuje urcit ¢ast obrazu jako prioritni. Tato oblast pak bude mit vyssi datovy tok a
tim padem i kvalitu obrazu. Kliknéte na Nastaveni (Config) > Obraz (Image) > ROI.

Nastaveni
1. Zaskrtnéte Povolit (Enable) a kliknéte na Nakreslit oblast (Draw Area).
2. TaZenim mysi oznacte prioritni oblast.
3. Pomoci posuvniku nastavte uroven.
4. Kliknéte na Ulozit (Save).

4.2.6 Ovladani objektivu

Poznamka: Tato funkce je dostupna pouze u kamer s motorickym zoomem.

Kliknéte na Kliknéte na Nastaveni (Config) > Obraz (Image) > Zoom/Ohnisko (Zoom/Focus).

» Zaostfeni pri prepnuti den a noc (Day and night switching Focus): kamera se
automaticky zaostfi pri pfepnuti mezi dennim a no¢nim reZimem
Zaostreni jednou klavesou (One Key Focus): po kliknuti na toto tlacitko se kamera zaostfi
Zoom -/+: oddaleni/ptibliZeni obrazu
Focus -/+: zmenSeni/zvétSeni ohniskové vzdalenosti
Reset: uvedeni vySe zminénych parametrii do tovarniho nastaveni

YV VYV
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4.3 Alarmy

4.3.1 Detekce pohybu
Kliknéte na Nastaveni (Config) > Alarm > Detekce pohybu (Motion Detection).

1.

Zaskrtnéte Povolit (Enable), pak nastavte dobu trvani alarmu a alarmové akce podle

potieby.

=> Doba trvani alarmu (Alarm Holding Time): po tuto dobu budou ignorovany dalsi
alarmové signaly (budou povazovany za soucast pohybu, ktery spustil alarm)

=> Alarmovy vystup (Alarm Out): pri alarmu se pfepne alarmovy vystup

=» Spustit momentku na SD kartu (Trigger SD Card Snapshot): pfi alarmu systém
poridi momentku a uloZi ji na SD kartu

=» Spustit zaznam na SD kartu (Triggert SD Card Recording): pfi alarmu systém poridi
zaznam a ulozi ho na SD kartu

=» Spustit email (Trigger Email): pri alarmu systém zaSle upozornéni na prednastaveny
email; pokud je zaSkrtnuta volba Prilozit obrazek (Attach picture) k emailu bude
priloZena momentka

=» Spustit FTP (Trigger FTP): pokud jsou zaskrtnuty volby Spustit FTP (Trigger FTP) a
Pripojit obrazek (Attach Picture), pri alarmu systém zaSle momentku na
prednastaveny FTP server

Kliknéte na zaloZku Oblast a citlivest (Area and Sensitivity). Pomoci posuvniku nastavte

citlivost detekce. Pak zvolte Pridat (Add), kliknéte na Nakreslit oblast (Draw Area) a

taZzenim mysSi urCete oblast detekce. Pro smazani zvolte Smazat (Erase) a taZenim mysi

zvolte oblast, kterou chcete smazat. Pro oznaceni celé plochy kliknéte na Zveolit vSe )Select

All). Pro smazani vSech oblasti kliknéte na Smazat vSe (Clear All). Pokud kliknete na

Obratit (Invert), detekce bude probihat mimo oznacené oblasti.

Kliknéte na zaloZzku Planovac (Schedule) a nastavte casovy plan detekce (viz kapitola

UloZiste).

4.3.2 Alarm vyjimky
SD karta plna

1. Kliknéte na Nastaveni (Config) > Alarm > Alarm vyjimky (Exception Alarm) > SD
karta plna (SD Card Full).
2. Zaskrtnéte Povolit (Enable).
3. Nastavte Dobu trvani alarmu (Alarm Holding Time) a alarmové akce podle potieby (viz
kapitola Detekce pohybu).
Chyba SD karty
Tato funkce spusti alarm, pokud dojde k chybé pfi zapisu na SD Kkartu.
1. Kliknéte na Nastaveni (Config) > Alarm > Alarm vyjimky (Exception Alarm) > Chyba
SD karty (SD Card Error).
2. Zaskrtnéte Povolit (Enable).
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3. Nastavte Dobu trvani alarmu (Alarm Holding Time) a alarmové akce podle potieby (viz
kapitola Detekce pohybu).

TD-9441E3B-A - Cerna (2.8 mm) - 4MP venkovni IP kamera s IR

Kolize IP adres
Poznamka: Tato funkce je dostupna pouze u modelt s alarmovym vystupem.
1. Kliknéte na Nastaveni (Config) > Alarm > Alarm vyjimky (Exception Alarm) > Kolize
IP adres (IP Address Collision).
2. Zaskrtnéte Povolit (Enable) a nastavte Dobu trvani alarmu (Alarm Holding Time).
3. Zaskrtnéte Alarmovy vystup (Alarm Out).

Odpojeni kabelu
Poznamka: Tato funkce je dostupna pouze u modelt s alarmovym vystupem.
1. Kliknéte na Nastaveni (Config) > Alarm > Alarm vyjimky (Exception Alarm) > Kabel
odpojen (Cable Disconnected).
2. Zaskrtnéte Povolit (Enable) a nastavte Dobu trvani alarmu (Alarm Holding Time).
3. Zaskrtnéte Alarmovy vystup (Alarm Out).

4.3.3 Alarmovy vstup

Poznamka: Tato funkce je podporovana pouze nékterymi modely.

Kliknéte na Nastaveni (Config) > Alarm > Alarmovy vstup (Alarm Input).
1. Zaskrtnéte Povolit (Enable), pak nastavte Dobu trvani alarmu (Alarm Holding Time) a
Jméno senzoru (Sensor Name).
2. Nastavte alarmové akce podle potfeby (viz niZe).
=>» Alarmovy vystup (Alarm Out): pri alarmu se prepne alarmovy vystup
=>» Spustit momentku na SD kartu (Trigger SD Card Snapshot): pfi alarmu systém
poridi momentku a uloZi ji na SD kartu
=» Spustit zaznam na SD kartu (Triggert SD Card Recording): pfi alarmu systém poridi
zaznam a ulozi ho na SD kartu
=» Spustit email (Trigger Email): pri alarmu systém zaSle upozornéni na prednastaveny
email; pokud je zaSkrtnuta volba Prilozit obrazek (Attach picture) k emailu bude
priloZena momentka
=» Spustit FTP (Trigger FTP): pokud jsou zaskrtnuty volby Spustit FTP (Trigger FTP) a
Pripojit obrazek (Attach Picture), pri alarmu systém zaSle momentku na
prednastaveny FTP server
=> Propojeni s prepinanim den/moc (Day/might switch linkage): systém pfi alarmu
prepne mezi dennim a no¢nim reZimem
3. Kliknéte na Ulozit (Save) pro uloZeni nastaveni.
4. Kliknéte na zaloZzku Planovac (Schedule) a nastavte casovy plan detekce (viz kapitola
UloZiste).

Poznamka: Pokud zafizeni podporuje dva alarmové vstupy, je nutné jesté nastavit ID vstupu.
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4.3.4 Alarmovy vystup

Poznamka: Tato funkce je podporovana pouze nékterymi modely.

Kliknéte na Nastaveni (Config) > Alarm > Alarmovy vystup (Alarm Output).
ReZim alarmového vystupu (Alarm Out Mode):
» Propojeni s alarmem (Alarm Linkage): vystup se prepne pfi alarmu; zadejte Jméno

alarmového vystupu (Alarm Out Name), Dobu trvani alarmu (Alarm Holding Time) a Typ
alarmu (Alarm Type; NO - spinaci kontakt, NC - rozpinaci kontakt)

Rucni operace (Manual Operation): ru¢ni ovladani; zvolte Typ alarmu (Alarm Type; NO -
spinaci kontakt, NC - rozpinaci kontakt); kliknéte na Otevrit (Open) pro zapnuti alarmu,
kliknéte na Zavrit (Close) pro vypnuti alarmu

Propojeni s prepinanim den/moc (Day/Night Switch Linkage): vystup se prepne pri
prepnuti mezi dennim a nocnim reZimem; zvolte Typ alarmu (Alarm Type; NO - spinaci
kontakt, NC - rozpinaci kontakt), pak zapnéte (Oteviit/Open) nebo vypnéte (Zavrit/Close)
prepinani alarmového vystupu pfi prepnuti do Denniho reZimu (Day) a Nocniho reZimu
(Night) podle potreby

Casovani (Timing): zvolte Typ alarmu (Alarm Type; NO - spinaci kontakt, NC - rozpinaci
kontakt), pak zvolte Pridat (Add) a taZzenim mySi po fadku oznacte Casovy tsek podle
potieby; pro smazani zvolte Smazat (Erase) a taZenim mysSi po fadku oznacte tsek, ktery
chcete smazat; pokud kliknete na Ruc¢ni vstup (Manual Input), mtliZete nastavit ¢asovy
usek rucné, s presnosti na minuty

Poznamka: Pokud zafizeni podporuje dva alarmové vystupy, je nutné jesté nastavit ID vystupu.

4.3.5 Alarmovy server

Kliknéte na Nastaveni (Config) > Alarm > Alarmovy server. Zde kliknéte na Zménit (Edit).
Nastavte Adresu serveru (Server Address) a Port. Pokud zapnete ovéfovaci pulzy (Heartbeat),
nastavte interval.

Poznamka: Pro zobrazeni citlivych informaci kliknéte na zaviené oko. Pro skryti citlivych
informaci kliknéte na oteviené oko.

4.4 Udalosti

Pro zvySeni presnosti detekce se fid'te nasledujicimi doporucenimi.

Kamera by méla byt pripevnéna ke stabilnimu povrchu. Vibrace mohou zptisobit faleSné
poplachy.

Kamera by neméla mifit na reflexni povrch (zrcadlo, sklo, vodni hladinu, vyleSténou
podlahu, atd).

Neinstalujte kameru do tGzkych nebo prilis tmavych prostort.

Barva sledovaného objektu by se méla liSit od barvy pozadi.
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® Ujistéte se, Ze obraz je ostry v kteroukoliv denni i nocni dobu. Vyhnéte se podexponovani a
preexponovani scény.
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4.4.1 Opustény/chybéjici objekt

Tato funkce spusti alarm, pokud z oblasti detekce zmizi objekt, nebo se v ni naopak objevi. Kliknéte
na Nastaveni (Config) > Udalost (Event) > Opustény/chybéjici objekt (Object
Abandoned/Missing).

1. Zaskrtnéte Povolit (Enable) a zvolte typ detekce.

=> Povolit detekci opusténého objektu (Enable Abandoned Object Detection): alarm se
spusti, pokud se v oblasti detekce objevi objekt a nezmizi do nastavené doby

=> Povolit detekci chybéjiciho objektu (Enable Missing Object Detection): alarm se
spusti, pokud z oblasti detekce zmizi predmét a nevrati se do nastavené doby

=>» Trvani prodlevy (Duration of Delay): doba, po které dojde k vyhodnoceni alarmu; u
detekce opusténého objektu lze nastavit 10~3600 sekund; u detekce chybéjiciho objektu
lze nastavit 3~3600 sekund

2. Nastavte Dobu trvani alarmu (Alarm Holding Time) a alarmové akce podle potieby (viz
kapitola Detekce pohybu).

3. Kliknéte na Ulezit (Save) pro uloZeni nastaveni.

4. Kliknéte na zaloZzku Oblast (Area). Zde kliknéte na Nakreslit oblast (Draw Area) a
klikanim vytvorte uzavienou oblast. Pro smazani oblasti kliknéte na Smazat (Clear). Pro
dokonceni kliknéte na Zastavit kresleni (Stop Draw). Nakonec kliknéte na UlezZit (Save)
pro uloZeni nastaveni.

5. Kliknéte na zaloZku Planova€ (Schedule) a nastavte Casovy plan detekce (viz kapitola
UloZiste).

Instalacni podminky
1. Objekt by mél zabirat minimalné 1/50 celkové plochy obrazu a zaroven maximalné 1/3

plochy obrazu.

2. Detekce trva 3~5 sekund.

3. V oblasti detekce by nemélo dochazet k Castym zménam (prochazejici lidé, projizd€jici
vozidla, atd).

4. Hranice oblasti detekce musi byt nakreslena co nejbliZe sledovanému objektu pro zvysSeni
presnosti detekce.

5. Tato funkce nedokaZe urcit vlastnika objektu.

6. Tato funkce by neméla byt pouZivana v prostfedi s vyraznymi zménami osvétleni.

7. Tato funkce by neméla byt pouzZivana v prostfedi s ¢astymi zménami nebo velkym poctem
pohybujicich se objektt.

8. Adekvatni osvétleni a Zadné prekazky jsou velice diilezité pro spravné fungovani detekce.

4.4.2 Video vyjimka

Tato funkce detekuje zmény v obraze zplisobené vnéjsSimi vlivy. Kliknéte na Nastaveni (Config) >
Udalost (Event) > Video vyjimka (Video Exception).
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1.

3,
4.

Zaskrtnéte typ detekce podle potreby.

=> Detekce zmény scény (Scene Change Detection): detekce natoceni kamery

= Detekce rozmazani videa (Video Blur Detection): detekce rozmazani obrazu

=> Detekce abnormalni barvy (Abnormal Color Detection): detekce zmény barev
Nastavte Dobu trvani alarmu (Alarm Holding Time) a alarmové akce podle potieby (viz
kapitola Detekce pohybu).

Kliknéte na Ulozit (Save) pro uloZeni nastaveni.

Kliknéte na zalozku Citlivost (Sensitivity) a nastavte citlivost detekce.

Instalacni podminky

1.

2.

Automatické zaostfeni by mélo byt vypnuté za dcelem minimalizace rizika faleSnych
poplachd.
Tato funkce by neméla byt pouZivana v prostfedi s vyraznymi zménami osvétleni.

4.4.3 Piekroceni linie

Tato funkce spusti alarm, pokud cil urcitého typu prekro¢i prednastavenou linii. Kliknéte na
Nastaveni (Config) > Udalost (Event) > Prekroceni linie (Line Crossing).

1.

ok

Zaskrtnéte Povolit (Enable), pak zvolte typ momentky a typ cile.

=>» Ulozit piivodni obrazek (Save Original Picture): na SD kartu bude uloZena cela
momentka

=» Ulozit cilovy obrazek (Save Target Picture): na SD kartu bude uloZen vytez cile

=» Poznamka: Pro ukladani momentek do PC je nutné zapnout lokalni chytré tlozisté.

Kliknéte na Nastaveni (Config) > Systém > Lokalni nastaveni (Local Config). Zde

nastavte parametr Lokalni chytré uloziSté momentek (Local Smart Snapshot

Storage) na Otevieno (Open).

Clovék (Human): alarm se spusti, pokud linii pfekro¢i ¢lovék

Motorové vozidlo (Motor Vehicle): alarm se spusti, pokud linii prekroci vozidlo se 4

nebo vice koly (automobil, autobus, atd)

Nemotorové vozidlo (Non-motor Vehicle): alarm se spusti, pokud linii prekroci vozidlo

se 2 koly (motocykl, bicykl)

Poznamka: Lze zvolit vice typt cili soucasné. Pokud neni zvolen Zadny typ cile,

detekce nebude fungovat.

Tlacit trajektorii cile s neustalym spojenim (Push target trajectory with persistent

connection): Pokud je tato funkce zapnutd, systém bude zasilat mobilni aplikaci

soufadnice cile pri jeho detekci. Pokud je tato funkce vypnutd, systém bude zasilat

mobilni aplikaci souradnice cile pouze pfi alarmu.

Nastavte Dobu trvani alarmu (Alarm Holding Time).

Zaskrtnéte alarmové akce podle potreby (viz kapitola Detekce pohybu).

Kliknéte na Ulozit (Save) pro uloZeni nastaveni.

Kliknéte na zaloZku Oblast (Area). Zde zvolte Cislo linie (1~4) a zvolte povoleny smér

priuchodu (Direction). Pak kliknéte na Nakreslit oblast (Draw Area) a taZenim mysi

v v v Y
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vytvorte linii. Kliknéte na Smazat (Clear) pro smazani linie. Kliknéte na Zastavit kresleni
(Stop Draw) pro dokonceni. Nakonec kliknéte na Ulozit (Save) pro uloZeni nastaveni.

=» A <-> B: alarm se spusti pfi prichodu obéma sméry

=>» A -> B: alarm se spusti pri priichodu z A do B

=>» A <- B: alarm se spusti pri priichodu z A do B

Kliknéte na zaloZzku Planovac (Schedule) a nastavte casovy plan detekce (viz kapitola
UloZisté).

Instalacni podminky

1.

6.
7.

Automatické zaostfeni by mélo byt vypnuté za dcelem minimalizace rizika faleSnych
poplachd.

Tato funkce by neméla byt pouzZivana v prostiedi s velkym poctem stromil nebo vyraznymi
zménami osvétleni (napfiklad mnoho projizdéjicich automobilt se zapnutymi svétly). Scéna
by neméla byt priliS tmava.

Instalacni vySka kamery by méla byt minimalné 2.8 m.

Kamera by méla byt instalovana pod uhlem 45°.

Cil by mél zabirat minimalné 1% celkové plochy obrazu a zaroven maximalné 1/8 (12.5%
plochy obrazu).

Detekce trva 2 sekundy.

Adekvatni osvétleni a Zadné prekazky jsou velice diileZité pro spravné fungovani detekce.

4.4.4 Naruseni oblasti

Tato funkce spusti alarm, pokud cil urcitého typu vnikne do oblasti detekce. Lze ji pouZit naptiklad
pro stfezeni dilezZitych mist, nebezpecnych mist nebo mist s omezenym pristupem. Kliknéte na
Nastaveni (Config) > Udalost (Event) > NarusSeni oblasti (Region Intrusion).

1.

Zaskrtnéte Povolit (Enable), pak zvolte typ momentky a typ cile.

=» Ulozit ptivodni obrazek (Save Original Picture): na SD kartu bude uloZena cela
momentka

=>» Ulozit cilovy obrazek (Save Target Picture): na SD kartu bude uloZen vyrez cile

= Poznamka: Pro ukladani momentek do PC je nutné zapnout lokalni chytré tlozZiste.

Kliknéte na Nastaveni (Config) > Systém > Lokalni nastaveni (Local Config). Zde

nastavte parametr Lokalni chytré ulozisté momentek (Local Smart Snapshot

Storage) na Otevreno (Open).

Clovék (Human): alarm se spusti, pokud oblast narusi ¢lovek

Motorové vozidlo (Motor Vehicle): alarm se spusti, pokud oblast narusi vozidlo se 4

nebo vice koly (automobil, autobus, atd)

Nemotorové vozidlo (Non-motor Vehicle): alarm se spusti, pokud oblast narusi vozidlo

se 2 koly (motocykl, bicykl)

Poznamka: Lze zvolit vice typt cili soucasné. Pokud neni zvolen Zadny typ cile,

detekce nebude fungovat.

Tlacit trajektorii cile s neustalym spojenim (Push target trajectory with persistent

connection): Pokud je tato funkce zapnutd, systém bude zasilat mobilni aplikaci

v v v Y
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AR

soufadnice cile pri jeho detekci. Pokud je tato funkce vypnutd, systém bude zasilat
mobilni aplikaci soufadnice cile pouze pfi alarmu.
Nastavte Dobu trvani alarmu (Alarm Holding Time).
Zaskrtnéte alarmové akce podle potieby (viz kapitola Detekce pohybu).
Kliknéte na Ulozit (Save) pro uloZeni nastaveni.
Kliknéte na zaloZzku Oblast (Area). Zde kliknéte na Nakreslit oblast (Draw Area) a
klikanim vytvorte uzavienou oblast. Pro smazani oblasti kliknéte na Smazat (Clear). Pro
dokonceni kliknéte na Zastavit kresleni (Stop Draw). Nakonec kliknéte na Ulezit (Save)
pro uloZeni nastaveni.
Kliknéte na zalozku Planovac (Schedule) a nastavte casovy plan detekce (viz kapitola
Ulo7iste).

Instalacni podminky

1.

6.
7.

Automatické zaostfeni by mélo byt vypnuté za dcelem minimalizace rizika faleSnych
poplachd.

Tato funkce by neméla byt pouZivana v prostiedi s velkym poctem stromil nebo vyraznymi
zménami osvétleni (napfiklad mnoho projizdéjicich automobilli se zapnutymi svétly). Scéna
by neméla byt priliS tmava.

Instalacni vySka kamery by méla byt minimalné 2.8 m.

Kamera by méla byt instalovana pod thlem 45°.

Cil by mél zabirat minimalné 1% celkové plochy obrazu a zaroveil maximalné 1/8 (12.5%
plochy obrazu).

Detekce trva 2 sekundy.

Adekvatni osvétleni a Zadné prekazky jsou velice diileZité pro spravné fungovani detekce.

4.4.5 Vstup do oblasti

Tato funkce spusti alarm, pokud cil prekroc¢i hranici oblasti smérem dovnitf. Kliknéte na Nastaveni
(Config) > Udalost (Event) > Vstup do oblasti (Region Entrance).

1.
2.
3.
4.

Zapnéte detekci a zvolte typ momentky a typ cile.
Nastavte dobu trvani alarmu a alarmové akce.
UrcCete oblast detekce.

Nastavte Casovy plan detekce.

Nastaveni je stejné jako u NaruSeni oblasti.

4.4.6 Opusténi oblasti

Tato funkce spusti alarm, pokud cil prekroci hranici oblasti smérem ven. Kliknéte na Nastaveni
(Config) > Udaloest (Event) > OpusSténi oblasti (Region Exiting).

1.

2.
3.
4

Zapnéte detekci a zvolte typ momentky a typ cile.
Nastavte dobu trvani alarmu a alarmové akce.
Urcete oblast detekce.

Nastavte casovy plan detekce.
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Nastaveni je stejné jako u NaruSeni oblasti.

4.4.7 Pocitani prekroc€eni linie

Tato funkce pocita cile, které prekroci prednastavenou linii.
1. Kliknéte na Nastaveni (Config) > Udalost (Event) > Pocitani cilti podle linie (Target
Counting by Line).
2. Zaskrtnéte Povolit (Enable), pak zvolte typ momentky a typ cile.
=» Ulozit piivodni obrazek (Save Original Picture): na SD kartu bude uloZena cela
momentka
=>» Ulozit cilovy obrazek (Save Target Picture): na SD kartu bude uloZen vyrtez cile
= Poznamka: Pro ukladani momentek do PC je nutné zapnout lokalni chytré tlozZisté.

Kliknéte na Nastaveni (Config) > Systém > Lokalni nastaveni (Local Config). Zde

nastavte parametr Lokalni chytré ulozisté momentek (Local Smart Snapshot

Storage) na Otevreno (Open).

Clovék (Human): alarm se spusti, pokud linii pfekro¢i ¢lovék

Motorové vozidlo (Motor Vehicle): alarm se spusti, pokud linii prekroci vozidlo se 4

nebo vice koly (automobil, autobus, atd)

Nemotorové vozidlo (Non-motor Vehicle): alarm se spusti, pokud linii pfekroci vozidlo

se 2 koly (motocykl, bicykl)

Poznamka: Lze zvolit vice typt cili soucasné. Pokud neni zvolen Zadny typ cile,

detekce nebude fungovat.

Tlacit trajektorii cile s neustalym spojenim (Push target trajectory with persistent

connection): Pokud je tato funkce zapnutd, systém bude zasilat mobilni aplikaci

soufadnice cile prfi jeho detekci. Pokud je tato funkce vypnutda, systém bude zasilat
mobilni aplikaci soufadnice cile pouze pfi alarmu.
Prah zistavajicich (Staying Threshold): pokud pocet cilii ve specifikované oblasti
prekroci tuto hodnotu, spusti se alarm
=>» Zavrit momentku udalosti (Close Event Snapshot): pokud je tato funkce zapnuta,
zachycené momentky nebudou uloZeny na SD kartu ani zaslany NVR/mobilni
aplikaci/platformé

=» Vynulovani pocitani (Counting Reset): 1ze nastavit Denné (Daily)